Creo Parametric 8.0 Tutorial

Roger Toogood, Ph.D.
Lesson 2

Creating a Simple Object (Part I)
Introduction to Sketcher

Synopsis

Creating a part; introduction to Sketcher; sketch constraints; creating datum curves, protrusions, cuts; sketch diagnostics; using the dashboard; saving a part; part templates.

Overview of this Lesson

The main objective of this lesson is to introduce you to the general procedures for creating sketched features. We will go at quite a slow pace and the part will be quite simple (see Figure 1 on the next page), but the central ideas need to be elaborated and explored so that they are very clearly understood. Some of the material presented here is a repeat of the previous lesson - take this as an indication that it is important! Here’s what we are going to cover:

1. Creating a Solid Part
2. Introduction to Sketcher
   - Sketcher menus
   - Intent Manager and Sketcher constraints
   - Sketcher Diagnostics
3. Creating a Sketch
4. Creating an Extruded Protrusion
   - Using the Dashboard
5. Creating an Extruded Cut
6. Saving the part
7. Using Part Templates

Helpful Hint

It will be a good idea to browse ahead through each section to get a feel for the direction we are going, before you do the lesson in detail. There is a lot of material here which you probably won’t be able to absorb with a single pass-through.

Start Creo Parametric as usual. If it is already up, close all windows (except the base
window) and erase all objects in session using

File ➤ Manage Session ➤ Erase Current

and/or

File ➤ Manage Session ➤ Erase Not Displayed,

also available in the {Home} ribbon. Close the Navigator and Browser windows.

Creating a Simple Part

In this lesson, we will create a simple block with a U-shaped central slot. By the end of
the lesson your part should look like Figure 1 below. This doesn't seem like such a
difficult part, but we are going to cover a few very important and fundamental concepts
in some depth. Try not to go through this too fast, since the material is crucial to your
understanding of how Creo works. We will be adding some additional features to this
part in the next lesson.

We are going to turn off some of the default actions. This will require us to do some
things manually and to give you a better understanding of what the many default actions
are. Eventually you will come across situations where you don’t want the defaults and
you’ll need to know your way around these options.

Creating and Naming the Part

Click the {Home}: New button, or select File ➤ New. A window will open (Figure 2)
showing a list of different types and sub-types of objects to create (parts, assemblies,
drawings, and so on). In this lesson we are going to make a single solid object called a
part. Keep the default radio button settings

Part | Solid

IMPORTANT: Turn off (remove the check) the Use Default Template option at the
bottom. We will discuss templates at the end of this lesson.
Many parts, assemblies, drawings, etc., can be loaded simultaneously in the current session. All objects are identified by unique names\(^1\). A default name for the new part is presented in the window, something like [prt0001]. It is almost always better to have a more descriptive name. So, double click (left mouse) on this text to highlight it and then type in

[block]

(without the square brackets) as your part name. The Common Name of the part is an option for specifying an even more descriptive name. For example, you might have a number of part files named using a part or catalog number such as “TG123_A29”. This is not very descriptive, so you could enter a common name such as “small flat rubber washer”. We will not use common names in this tutorial, so leave this blank and just press Enter or select OK.

The New File Options dialog window opens. Since we elected (in the previous window) to not use the default template for this part, Creo is presenting a list of alternative templates defined for your system. As mentioned previously, we are going to avoid using defaults this time around. So, for now, as shown in Figure 3 at the right, select Empty | OK (or middle click).

At this time, BLOCK should appear in the title area at the top of the graphics window and the part modeling ribbon has appeared.

Create Datum Planes

We will now create the first features of the part: three datum planes to locate it in space. It is not absolutely necessary to have datum planes, but it is a very good practice, particularly if you are going to make a complex part or assembly. Datum planes are created using the Plane \(\mathbb{D}\) command in the \{Model\}:Datum group. Note that this button looks quite similar to the buttons that control the display of datums and tags in the \{View\}:Show group of the ribbon. What’s the difference?

Select the Plane button now. Since we currently have no features in the model, Creo rightly assumes that we want to create the three standard datum planes. Normally this command only creates a single datum plane at a time. In the \{View\}:Show group, make sure that display of all datums and tags is turned on.

\(^1\) Creo can keep track of objects of different types with the same names. A part and a drawing can have the same name since they are different object types.
The datum planes represent three orthogonal planes to be used as references for features that will be created later. You can think of these planes as XY, YZ, XZ planes, although you generally aren’t concerned with the X,Y,Z form or notation. Your screen should have the datum planes visible, as shown in Figure 4. Note that each plane has an attached tag that gives its name: DTM1, DTM2, and DTM3. This view may be somewhat hard to visualize, so Figure 5 shows how the datum planes would look if they were solid plates in the same orientation. An important point to note is, while the plates in Figure 5 are finite in size, the datum planes actually extend off to infinity. Finally, before we move on to the next topic, notice that the last feature created (in this case DTM3) is highlighted in green. This is a normal occurrence and means that the last feature created is always preselected for you as the “object” part of the object/action command sequence.

**Figure 4** Default datum planes

**Figure 5** Datum planes as solid plates

---

**Part Modeling Feature Overview**

There are three command groups in the `{Model}` tab of the modeling ribbon that will create solid features. These are shown in Figure 6. Two of these groups contain commands for creating single features, organized into the following categories:

<table>
<thead>
<tr>
<th>Shapes</th>
<th>Engineering</th>
<th>Editing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extrude</td>
<td>Hole</td>
<td>Mirror</td>
</tr>
<tr>
<td>Revolve</td>
<td>Draft</td>
<td>Extend</td>
</tr>
<tr>
<td>Sweep</td>
<td>Sketch</td>
<td>Project</td>
</tr>
<tr>
<td>Swept Blend</td>
<td>Shell</td>
<td>Trim</td>
</tr>
<tr>
<td>Chamfer</td>
<td>Rib</td>
<td>Offset</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Thicken</td>
</tr>
</tbody>
</table>

**Shapes** (formerly known as “sketched features”) - (extrusions, revolves, sweeps, ...)

These features require the definition of a two-dimensional cross section which is then manipulated into the third dimension. All of these features can either add or remove material from the solid. These features will involve the use of an important tool called
Sketcher. This will be the focus of this lesson.

**Engineering** (formerly known as “placed features”) - (holes, rounds, shells, ...) These are features that are created directly on existing solid geometry. Some always either add (rib) or remove (hole) material from the solid. Some (round, chamfer, draft) can do both, depending on the underlying geometry. Examples are placing a hole on an existing surface, or creating a round on an existing edge of a part.

The third group of buttons, **Editing**, is used for modifying existing features. We will deal with some of these commands (**Mirror** and **Pattern**) later in the Tutorial.

In this lesson we will be using the **Extrude** command to create two types of shaped features (a protrusion and a cut). In the next lesson, we will use the **Hole**, **Round**, and **Chamfer** commands to create three engineering features. Before we continue, though, we must find out about an important tool - Sketcher.

---

**Introducing Sketcher**

Sketcher is arguably the most important tool for creating features in Creo Parametric. It is therefore critical that you have a good understanding of how it works. We will take a few minutes here to describe its basic operation and will explore the Sketcher tools continually through the next few lessons. It will take you a bit of practice and experience to fully appreciate all that it can do.

Basically, Sketcher is a tool for creating two-dimensional figures. These can be either stand-alone features (**Sketched Curves**) or embedded elements that define the cross sectional shape of some solid features. The aspects of these figures that must be defined are location, shape, and size, roughly in that order. The sketching plane where we will create the 2D sketch is defined or selected first. Then, within Sketcher the location is further specified by selecting references to existing geometry. You will find the usual drawing tools for lines, arcs, circles, and so on, to create the shape. Finally, you can specify dimensions and/or alignments to control the size of the sketch and its relation to existing geometry.

Sketcher is really quite smart, that is, it will anticipate what you are going to do (usually correctly!) and do many things automatically. Occasionally, it does make a mistake in guessing what you want. So, learning how to use Sketcher effectively involves understanding exactly what it is doing for you (and why) and discovering ways that you can easily override this when necessary.

The brain of Sketcher is called the **Intent Manager**. We will be discussing the notion of **design intent** many times in this tutorial. In Sketcher, design intent is manifest not only in the shape of the sketch but also in how constraints and dimensions are applied to the

---

\(^2\) Sketcher tools can also be used in drawing mode to create drawing entities.
sketch so that it is complete and conveys the important design goals for the feature. Completeness of a sketch implies that it contains just enough geometric specification so that it is uniquely determined. Too little information would mean that the sketch is under-specified; too much means that it is over-specified. One function of Intent Manager is to make sure that the sketch always contains just the right amount of information. Moreover, it tries to do this in ways that, most of the time, make sense. Much of the initial frustration involved in using Sketcher arises from not understanding (or even sometimes not realizing) the nature of the choices it is making for you\(^3\) or knowing how easy it is to override these actions. When you are using Sketcher, Intent Manager must be treated like a partner - the more you understand how it works, the better the two of you will be able to get along!

The term *sketch* comes from the fact that you do not have to be particularly exact when you are “drawing” the shape, as shown in Figures 7 and 8. Sketcher (or rather Intent Manager) will interpret what you are drawing using a built-in set of rules. Thus, if you sketch a line that is approximately vertical, Sketcher assumes that you want it vertical. If you sketch two circles or arcs that have approximately the same radius, Sketcher assumes that’s what you want. In cases like this, you will see the sketched entity “snap” to a particular orientation or size as Intent Manager fires one of its internal rules (this occurs on-the-fly while you are sketching).

![Figure 7 Geometry before processing by Intent Manager. Note misaligned vertices, non-horizontal and vertical edges, no tangent curves.](image1)

![Figure 8 Geometry after processing by Intent Manager. Note aligned vertices, horizontal and vertical edges, tangent curves.](image2)

When Intent Manager fires one of its internal rules, you will be alerted by a symbol on the sketch that indicates the nature of the assumed condition. If you accept the condition, it becomes a *constraint* on the sketch. These constraints are summarized in Table 2-1.

---

\(^3\) Intent Manager is able to “solve” sketches that are much more complicated than mere humans can do. To make sure it doesn’t get ahead of you, keep your sketches simple.
Table 2-1 Implicit Constraints in Sketcher

<table>
<thead>
<tr>
<th>Rule</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal radius and diameter</td>
<td>![Equal Symbol]</td>
<td>If you sketch two or more arcs or circles with approximately the same radius, the system may assume that the radii are equal.</td>
</tr>
<tr>
<td>Symmetry</td>
<td>![Symmetry Symbol]</td>
<td>Two vertices may be assumed to be symmetric about a centerline.</td>
</tr>
<tr>
<td>Horizontal or vertical lines</td>
<td>![Horizontal or Vertical Lines]</td>
<td>Lines that are approximately horizontal or vertical may be considered to be exactly so.</td>
</tr>
<tr>
<td>Parallel or perpendicular lines</td>
<td>![Parallel or Perpendicular Lines]</td>
<td>Lines that are sketched approximately parallel or perpendicular may be considered to be exactly so.</td>
</tr>
<tr>
<td>Tangency</td>
<td>![Tangency Symbol]</td>
<td>Entities sketched approximately tangent to each other may be assumed to be tangent.</td>
</tr>
<tr>
<td>Equal segment lengths</td>
<td>![Equal Length Symbol]</td>
<td>Lines of approximately the same length may be assumed to have the same length.</td>
</tr>
<tr>
<td>Point entities lying on other entities or collinear with other entities</td>
<td>![Collinear Symbol]</td>
<td>Point entities that lie near lines, arcs, or circles may be considered to be exactly on them. Points that are near the extension of a line may be assumed to lie on it.</td>
</tr>
<tr>
<td>Equal coordinates</td>
<td>![Equal Coordinates Symbol]</td>
<td>Endpoints and centers of the arcs may be assumed to have the same X- or the same Y-coordinates.</td>
</tr>
<tr>
<td>Midpoint of line</td>
<td>![Midpoint Symbol]</td>
<td>If you sketch close to the midpoint of a line the vertex will snap there.</td>
</tr>
</tbody>
</table>

You should become familiar with these rules or constraints, and learn how to use them to your advantage. If you do not want a rule invoked, you must either  
(a) use explicit dimensions or alignments, or  
(b) exaggerate the geometry so that the rule will fail, or  
(c) tell Sketcher to disable a specific instance of the constraint (Hint: RMB), or  
(d) set up Sketcher to explicitly ignore constraints of a given type.

You will most often use option (a) by specifying your desired alignments and dimensions and letting Sketcher worry about whatever else it needs to solve the sketch. When geometry is driven by an explicit dimension, fewer internal rules will fire. Option (b) is slightly less common. An example is a line that must be 2° away from vertical - you would draw it some much larger angle (like 15° or so - this prevents the “vertical” rule from firing) and put an explicit dimension on the angle. Once the sketch has been completed with the exaggerated angle, you can modify the dimension value to the desired...
2°. The third option is used on-the-fly while you are sketching to disable a constraint that Intent Manager indicates it wants to place. Finally, there are settings for Sketcher that explicitly turn off the rule checking (for all rules or selected ones only) during sketching. This is very rarely used.

An example of a sketch with geometric constraints is shown in Figure 9. Note how few dimensions are required to define this sketch. See if you can pick out the following constraints:
- vertical lines
- horizontal lines
- perpendicular lines
- four tangencies
- three sets of equal length lines
- equal radius and diameter
- vertical alignment

How do you suppose Sketcher is able to determine the radius of the rounded corners (fillets) at the top and bottom on the left edge? (Hint: this involves the solution of a system of equations.)

Sketcher has some very useful tools that make it quite easy to diagnose errors in sketches (such as duplicated edges) or improper sketches (such as open curves for features that require closed curves). We will investigate these tools by intentionally introducing some errors into our sketches.

**Two Ways to use Sketcher to Create Shaped Features**

In this lesson, we will use two methods to create a couple of shaped features. The creation of the sketch represents the majority of the work required in creating these features. The two methods will differ by when in the feature creation sequence you will invoke Sketcher. The two methods are shown schematically in Table 2 - 2.

In the first method, we invoke Sketcher first to create the cross sectional shape of the extrusion. This shape is defined in a *sketched curve* which becomes a stand-alone feature in the model. We then launch the extrude command, specifying the curve to define the cross section of the feature. A dependent copy of the sketch is brought into the extrude feature. The original sketch feature is automatically set to *Hide*, although it can still be used as a reference by other features. In the second method, we do not create a separate curve but rather invoke Sketcher from inside the extrusion creation sequence. In this case, the sketch exists only inside the extrude definition and is not usable by other features. In the Table below, notice the difference in the appearance of the model tree following completion of the extruded feature.
Creating a Simple Object (Part I)

Table 2-2 Steps to create a sketched feature

<table>
<thead>
<tr>
<th>Step</th>
<th>Method #1</th>
<th>Method #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create shape using Sketcher (sketch becomes stand alone feature)</td>
<td>Launch Extrude tool</td>
</tr>
<tr>
<td>2</td>
<td>Launch Extrude tool</td>
<td>Create shape using Sketcher (sketch exists only inside the extrude feature)</td>
</tr>
</tbody>
</table>

In terms of design intent, the first method would be used if the curve was used for more than one feature, for example an extrude and a subsequent revolve. The second (creating the sketch within the feature) is the traditional mode of operation, and would be the method of choice if the sketched shape was used only for that single feature.

Both features we will make in this lesson are extrusions: one will be a protrusion (which adds material) and the other is a cut (which removes material). Either of the two methods shown here can be used to create either protrusions or cuts; for either method, whether you add or remove material is determined by an option button, or the direction of the extrusion away from a solid surface (away produces a protrusion, into produces a cut).

There is a third way to use sketches to create complicated shaped features. This uses Sketch Regions formed by curves and lines from multiple separate sketches. This topic will be discussed later in these lessons. Sketches can also be used to create hole patterns.

Creating a Sketched Curve

The last feature we created in the Block model was the datum DTM3. If that is currently selected (highlighted in green), unselect it by clicking somewhere else in the graphics window. The behavior of Sketcher is different if we enter it with a plane already selected.

Now in the {Model}:Datum group select the Sketch tool.

Setting Sketch Orientation

The Sketch dialog window opens (Figure 10) where we must specify two references. The first is the Sketch Plane. Select the border of DTM3. It is now highlighted in the graphics window in cyan. This is the plane on which we will draw the sketch. Sketcher
will automatically pick the second reference, probably DTM1, but this will depend on the orientation of the datum planes on your screen. It will automatically assign an **Sketch Orientation** - see Figure 10. This also depends on the current orientation of the datums\(^4\).

A magenta arrow shows the direction of view onto the sketching plane. Spin the orientation with the middle mouse button to see the arrow. The arrow attached to the edge of DTM3 should be pointing back into the screen. The direction of view can be reversed by clicking directly on the magenta arrow or with the **Flip** button in the dialog window. Leave it pointing towards the back. In the dialog window, DTM1 is identified as the Sketch Orientation **Reference**, with the **Orientation** set to **Right**. What is all this about?

The relation between the sketch plane and the sketch orientation reference generally causes confusion for new users, so pay attention!

The meaning of the sketch plane is pretty obvious - it is the plane on which we will draw the sketch - in this case DTM3. The best 2D view is always perpendicular to the sketch plane\(^5\). That is not enough by itself to define our view of the sketch since we can be looking at that plane from an infinite number of orientations (imagine the sketch plane rotating around an axis perpendicular to the screen). The **Orientation** option pull-down list in the dialog window (**Top**, **Bottom**, **Left**, **Right**) refers to directions relative to the computer screen, as in “TOP edge of the screen” or “BOTTOM edge of the screen” and so on. We must combine this direction with a chosen reference plane (**which must be perpendicular to the sketch plane**) so that we get the desired orientation of view onto the sketching plane.

So that the sketch is the right way up, we can choose either DTM2 to face the Top of the screen, or (as was chosen automatically for us) DTM1 can face the Right of the screen. Note that both DTM1 and DTM2 are both perpendicular to the sketch plane, as required. The direction a plane or surface “faces” is determined by its normal vector which, for a datum plane, is perpendicular to the positive side. For a solid surface, the orientation is determined by the outward normal.

Read the last couple of paragraphs again, since new users are quite liable to end up drawing their sketches upside-down or (like the example below) sideways!

---

\(^4\) If the dialog window do not look like Figure 10, cancel out of the window, press Ctrl-D to get to the default orientation, and launch the Sketch command again.

\(^5\) It is possible to sketch in 3D (in fact that is the default) but all entities still lie only in the designated sketch plane.
To illustrate the crucial importance of the reference plane, consider the images shown in Figure 11. These show two cases where the same sketching plane DTM3 was used, the same sketched shape was drawn, the same reference orientation TOP was chosen, but where different datums were chosen as the sketching orientation reference. On the left, the TOP reference was DTM2. On the right, the TOP reference was DTM1. The identical sketch, shown in the center, was used for both cases (rounded end of sketch towards the top of the screen). However, notice the difference in the orientation of the part obtained in the final shaded images. Both of these models are displayed in the default orientation (check the datum planes). Clearly, choosing the sketching reference is important, particularly for the base feature (the first solid feature in the part).

Let’s continue on with creating the curve. Make sure the Sketch dialog window is completed as in Figure 10. Select the Sketch button (or middle click).
Several changes occur on the screen. First, a new ribbon tab has appeared containing the sketching tools. Second, three new buttons have shown up on the Graphics toolbar. Take a moment to check these out with the pop-up tool tips. Finally, a couple of dashed cyan lines have appeared in the graphics area. What are these about?

To verify the meaning of the dashed lines, in the Sketch:Setup group select References (or select References in the RMB pop-up). This opens the References dialog window, Figure 12. In this window we can select any existing geometry to help Sketcher locate the new sketch relative to the part. In the present case, there isn’t much to choose from, and two references have already been chosen for us - DTM1 and DTM2. The intersection of these datums with the sketch plane produces the two dashed lines. The number of references you choose is not limited (there may be several listed here) and a reference can be any existing geometric entity (plane, straight or curved edge, point, axis, projected edge, and more). You are also free to delete the ones chosen for you and/or add new ones. However, notice the Sketch Status at the bottom of this dialog. Fully Placed means enough references have been specified to allow Sketcher to locate your sketch. If there are not enough references, the status will be Unsolved Sketch. For now, do not proceed beyond this window unless you have a Fully Placed status indicated. If you have changed the references, use the Update the Sketch button at the lower right. Once the sketch is fully placed, select Close in the References window.

So that we are looking directly at the sketch plane, in the Graphics toolbar select the Sketch View button. The graphics window is shown in Figure 13. Note that you are looking edge-on to the datums DTM1 and DTM2. The positive side of datum DTM1 is facing the right edge of the screen, as specified back in Figure 10. Note that we could have obtained the same orientation by selecting DTM2 to face the top of the screen.

In the Graphics toolbar there is a new set of Sketcher Display Filters (Figure 14). Leave these options in their default value (Dimensions, Constraints, Vertices, all turned on). It is seldom (if ever) that you will need to turn on the grid in Sketcher. We will discuss
dimension locks a bit later on. The major change on the screen is the Sketch ribbon. Let’s take some time to explore it.

The Sketch Ribbon

The Sketch ribbon is shown in Figures 15 and 16. You should explore the groups for a while to familiarize yourself with the commands available. Some things you should note about the groups and commands are the following (starting from the left):

**Setup** - allows you to reset the sketch plane and references, sketching options, and to reorient your sketch view (note this button is also on the Graphics toolbar).

**Get Data** - lets you read in a previously created sketch.

**Operations** - these include the normal selection, cut, copy, paste commands.

**Datum** - these buttons will create entities in the sketch that will appear and operate the same as datums in the model, but they are stored within the sketch. These were previously called geometry datums. They will create a datum element that is visible outside the sketch (and could be used as reference by another feature). For example, a *Geometry Point* creates a datum axis that will be perpendicular to the sketch plane.

**Sketching** - these will be your most-used commands. The *Construction Mode* button will toggle between real geometry and construction geometry. Real geometry will produce the feature, while construction geometry is only used to help define the sketch. An example would be using a construction circle to create an inscribed hexagon. You can also switch entities from construction to real (or vice versa) after they have been created. The rest of the sketching buttons do the actual geometry creation. Note that most buttons have flyouts to show variations of the command. For example, check out the rectangle button. We will spend a lot of time exploring some of these options. Finally, the *Palette* command lets you choose from several different families of 2D shapes that have already been created for you. We will use this command a bit later in these lessons.
Editing - contains commands for modifying geometry by changing dimensions using a special dialog window, trimming (and extending) entities, mirroring of entities, dynamic trim, and translating, rotating, and scaling a group of entities simultaneously.

Constrain - these are the constraints that Intent Manager will invoke automatically, but you can also explicitly assign these constraints to a sketch. See Table 2-3 on page 15.

Dimension - does pretty much what you would expect - allow you to create dimensions on the sketch. There are several varieties, including reference, ordinate, and perimeter.

Inspect - these contain tools to help you diagnose problems with your sketch. For our first sketch, turn on the Shade Closed Loops and Highlight Open Ends buttons.

Close - lets you accept the sketch or quit without keeping or using the sketch. Note that the latter is irreversible (you cannot Undo it).

It is going to take a while to get comfortable with all the commands in the ribbon. Fortunately, there is a small subset that will be used repeatedly.

Helpful Hint
In the following, keep in mind that many functions in Sketcher are available in context sensitive pop-up menus attached to the RMB. For many sketches, you need never actually pick a ribbon button since almost everything is available in the graphics window using RMB commands only. Try it!
Table 2-3 Explicit Constraints in Sketcher

<table>
<thead>
<tr>
<th>Constraint</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tangent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symmetric</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-point</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Equal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perpendicular</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coincident</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parallel</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Creating the Sketch

Select the **Line Chain** tool using one of the following three methods:

- using the **Line Chain** button in the Sketching group,
- OR (probably the easiest!)
- hold down the RMB and select **Line Chain** from the top row in the pop-up menu (Figure 17).

You will now see a small X with a dot at its center which will chase the cursor around the screen. Notice that the X will snap to the dashed references (which turn bright green) when the cursor is brought nearby, but not to the displayed edges of DTM3. While you are creating the sketch, watch for entities turning green that indicate Intent Manager is firing an internal rule to set up a constraint (Vertical, Horizontal, Equal Length). These symbols will come and go while you are sketching. The trick with Sketcher is to get Intent Manager to fire the rule you want, then click the left mouse button to accept the position of the vertex. Click the corners in the order shown in Figure 18. After each click, you will see a straight line rubber-band from the previous position to the cursor position:

---

6 The sketcher constraints will appear while you are sketching if the configuration option **show_sketcher_constr_dyn_edit** is set to **Yes**. The default is **No**.
1. left-click at the origin (intersection of DTM1 and DTM2)
2. left-click above the origin on DTM1 (watch for Vertical)
3. left-click horizontally to the right (watch for Horizontal and Equal Length - we do not want Equal Length)
4. left-click straight down on DTM2 (watch for Vertical)
5. left-click back at the origin
6. middle-click anywhere on the screen to end line creation

**Figure 18** Drawing the Sketch

When you are finished with this sequence, you are still in **Line** creation mode (notice the X on screen and the **Line Chain** ribbon button). If you middle click again, you will leave that and return to **Select** mode - the same as if you picked on the **Select** button in the ribbon, but much faster.

**Helpful Hint**
From wherever you are in the Sketcher menu structure, a single **middle** mouse click will often abort the current command and return you to the toolbar with the **Select** command already chosen. Sometimes, you may have to click the middle button twice (the second time is to clear a selected object).

The sketched entities are shown in green. Since we have created a closed curve, the interior of the sketch is shaded\(^7\) (because of the **Shade Closed Loops** button in the ribbon). Many features require sketches to contain only closed loops, so this is an easy way to verify that condition. At some point or other, you will create a sketch that you think is closed, but it will not shade. This usually means you have extraneous entities in the sketch (usually duplicated lines or edges) or the corners do not exactly close. We will see an example of duplicate lines in a few minutes.

Note that we didn't need to specify any drawing coordinates for the rectangle, nor, for that matter, are any coordinate values displayed anywhere on the screen. This is a significant departure from standard CAD programs. We also didn’t need the grid (this is available if you want it, along with a snap function).

You can also sketch beyond the displayed edges of the datum planes - these actually extend off to infinity. The displayed extent of datum planes will (eventually) adjust to the currently displayed object(s).

---
\(^7\) The color depends on a system color setting. See the Appendix.
Helpful Hints

If you make a mistake in drawing your shape, here are some ways to delete entities:
1. Pick the **Select** tool in the ribbon and left click on any entity you want to delete. Then either press the **Delete** key on the keyboard, or hold down the RMB and choose **Delete**.
2. If there are several entities to delete, hold the CTRL key down while you left click on each entity. Then pick **Delete** as before.
3. You can left-click and drag to form a rectangle around a set of entities. Anything completely inside the rectangle is selected. Use **Delete** as before.
4. Notice the **Undo** and **Redo** buttons in the Quick Access Toolbar.

We will cover more advanced Sketcher commands for deleting and trimming lines a bit later.

After you have finished the sequence above, Sketcher will put two dimensions on the sketch - for the height and width of the rectangle. These will be in light blue, similar to those shown in Figure 19. For the first feature in a part, the numerical values of these dimensions are picked more-or-less at random (although they are in correct proportion to each other). For later features in the part, Sketcher will know the sketch size more accurately because it will have some existing geometry to set the scale.

If you select a dimension or constraint icon, the relevant entities will highlight in red - very handy!

**Weak vs Strong Dimensions**

A dimension created by Sketcher (or actually Intent Manager) is called “weak” and is shown in light blue. Strong dimensions (dark blue), on the other hand, are those that you create explicitly. You can make a strong dimension in any of three ways:

- modify the numeric value of a weak dimension
- create a dimension from scratch by identifying entities in the sketch and placing a new dimension on the sketch
- select a weak dimension and promote it to strong using the pop-up menu

---

8 The default datum display with no other features present is actually ±250 units from where they cross.

9 Incidentally, reference to entity colors assume the default system colors. Yours may be somewhat different due to system customization settings.
The special significance of weak and strong dimensions is critical. When Intent Manager is “solving” a sketch, it considers the sketch references, any implicit rules that have fired and any existing dimensions. If there is not enough information to define the drawing (it is underconstrained), Sketcher will create the necessary and sufficient missing dimensions. These are the weak dimensions. If Sketcher finds the drawing is overconstrained (too many dimensions or constraints) it will first try to solve the sketch by deleting one or more of the weak dimensions (the ones it made itself earlier). It will do this without asking you. This is one way for you to override Intent Manager - if you don’t like the dimensioning scheme chosen by Sketcher, just create your own (automatically strong) dimensions. Sketcher will remove whichever of the weak dimensions are no longer needed to define the sketch. Sketcher assumes that any strong dimensions you have created shouldn’t be messed with! However, if Sketcher still finds the drawing overconstrained, it will tell you what the redundant information is (either dimensions or constraints), and you can choose what you want deleted. Thus, although weak dimensions can be deleted without asking you, Sketcher will never delete a strong dimension without your explicit confirmation unless you are deleting one of the entities being dimensioned.

We want to modify the two weak dimensions on the rectangle in a couple of ways. First, we can make a cosmetic improvement by selecting the dimension text (the number) and performing a drag-and-drop to move it to a better location. Note in passing that preselection highlighting also works with dimensions and constraints. Do that now, so that the dimensions are located as in Figure 20 (“off the sketch”).

Next, we can change the numeric values of the dimensions. It is explained later why it is not a good idea to do this now but we will anyway to show why it is not a good idea! Double-click on the horizontal dimension. In the text entry box, enter the value 20. When you hit Enter, the sketch geometry will be updated with this new dimension. The dimension is now strong. Change the vertical dimension to 30. It will also now be strong. (Click anywhere on the graphics window to remove the green highlight and update the shading.) See Figure 20. Both dimensions are now in dark blue.

Notice that the indicated extent of the datum plane DTM3 adjusts to the sketch. You may
want to **Refit** the sketch in the graphics window (or use zoom).

Now we’ll add a couple of rounded corners, technically known as fillets, on the top corners of the sketch to help us “see” the orientation of the feature in 3D. Select the **Arc** command from the RMB pop-up menu ( ) and pick on the top and right lines in the sketch close to but not at the corner. A circular fillet is created to the pick point closest to the corner. Two tangent constraints are added, along with a weak dimension for the fillet radius. Do the same on the top and left lines. Middle click to return to Select mode.

**IMPORTANT:** Because our fillet command has removed two vertices on the top of the sketch, Intent Manager has removed our two strong dimensions (which used those vertices) and replaced them with weak ones (see the message window - you may have to scroll back a couple of lines). So really we wasted a couple of steps by previously modifying the values of those dimensions (and making them strong in the process). You can make them strong again by selecting them, and selecting **Strong** in the pop-up menu. Modify the cosmetics and values of the fillet radius dimensions as shown in Figure 21.

---

**Helpful Hint**

When you are creating a Sketch, the most efficient order of operations is the following:

1. Make sure you have the **references** you want.
2. Create the **geometric shape** you want.
3. Make sure the **constraints** you want have appeared.
4. Add the **dimensions** that you want to control the sketch. Intent Manager will remove any weak ones no longer needed.
5. Modify the dimension **cosmetics** to take the dimensions off the sketch.
6. Change the dimension **values** to the ones you want. Be aware of decimal places since the displayed values may be rounded off (precision is a system setting).

If you do not do things in this order, you will likely have to backtrack (as we did above by respecifying the strong dimensions for the block).

---

**Sketcher Diagnostic Functions**

At this point, we have a completed and valid sketch. Select the **Feature Requirements** button in the Sketch tools menu at the top. The window that opens indicates that the sketch is okay (all requirements check out). Let’s introduce a common error into the sketch to see what happens. Close the **Feature Requirements** window.

We will create a duplicate line on the sketch using **Line Chain**. Start at the bottom left corner and end the line part way up the vertical edge towards the top, overlapping the existing line. When you finish the line and return to Select mode (remember to middle click twice), three things will happen. First, the sketch is no longer shaded, indicating that it is no longer a simple closed loop. Second, a big red square appears where the
overlapping line ends. This indicates an open (that is, unconnected) end of the sketch (if
the **Highlight Open Ends** button in the **Inspect** group in the ribbon is on). Third, a
weak dimension will appear for the new line. Although the geometry of the sketch
appears visually correct, if we tried to use it to create a solid feature it would fail. Now
pick the **Overlapping Geometry** button in the **Inspect** group. All lines touching the
offending vertical line will highlight in red (easier to see with the datum plane display
turned off). At this point, you would have to do some detective work to figure out where
the problem was. Select the short vertical line (note that preselection works here) and
delete it. The red square disappears and the sketch is again shaded.

You should experiment with the Sketch Diagnostic tools periodically as we proceed through the tutorial.

This completes the creation of our first sketch. Select the **OK** in the ribbon, or in the RMB pop-up menu. This
returns us to the regular graphics window with our new sketched curve shown in green (last feature created). You
can spin the model around with the middle mouse button to see this curve from different view points. When you are
finished with this, return the model to approximately the default orientation - Figure 22. If you click anywhere else
on the graphics window, the curve turns its default color of light blue.

### Creating a Solid Protrusion

Most of the work to create this feature has been done already - creating the sketched curve that defines its
shape. This curve should be highlighted in green. If you have been playing around with the model and the
sketch is blue, just left click on it to select it again.

With the sketched curve highlighted, pick the **Extrude** button in the **Shapes** group of the ribbon or in the
middle row of the pop-up menu.

What you will see now is an orange shaded image of the protrusion, Figure 23. On this shape, you will see a
magenta arrow that indicates the extrusion direction, which by default comes off the positive side of the

---

10 This sketch could be used to create an extruded surface feature, but with
overlapping surfaces, probably not a good idea. For an extruded solid, the feature would
fail with an error message about requiring a closed section only.
sketch. There is also a dashed line ending in a yellow circle. This is a drag handle. Click on this with the mouse and you can drag it to change the length of the extrusion. This length is also shown in a dimension symbol. You can even drag this extrusion out the back of the sketch to extrude in the opposite direction. This direct manipulation of the feature on the screen is called, in Creo Parametric vernacular, *Direct Modeling*. Bring the protrusion out the front and double click on the numeric dimension, and enter the value 30.

Check out what happens if you hold down the RMB with nothing selected. What is in the pop-up menu? What happens if you select the yellow drag handle? It should turn blue. What is in the RMB menu now? We will explore these options later.

At the top of the graphics window is a new collection of tools. These comprise the *Dashboard* for the extrude feature. Many features are constructed with tools arranged using this style of interface element. It is worth spending some time exploring this one in detail, since you will probably be using it the most.

---

**Helpful Hint**

You may accidentally leave the dashboard with an inadvertent click of the middle mouse button. Remember that this is a short cut for *Accept*. If that happens, with the protrusion highlighted, select the *Edit Definition* button at the top of the pop-up menu. This will bring you back to the dashboard. The *Undo* command, if executed immediately, will delete the feature.

---

**The Extrude Dashboard**

The dashboard collects all of the commands and options for feature creation in an easily navigated interface. Moreover, most optional settings have been set to default values which will work in the majority of cases. You can change options at any time and in any order, often by using a RMB pop-up menu.

The feature being created is identified by the ribbon tab at the top of the dashboard as well as the icon at the left end of the dashboard. The dashboard itself contains two areas. On the left (Figure 24) are commands, settings, and so on for the particular feature under construction. The ones showing are context sensitive so with a different feature (like a hole) you will see different commands. The following are for an extrude:
Solid and Surface buttons - these are an either/or toggle set. The default is to create a solid. If you pick Surface, the sketch will be extruded as an infinitely thin surface (Figure 25). Return this to the Solid selection.

Depth - the next button is a drop-down list of all the possibilities for specifying the depth of the extrusion. These are indicated in Figure 26. The default is a Variable depth (previously known as Blind), which means the extrusion is for a fixed distance. Other options may appear here as more part geometry appears (as in the cut which we will do next). The Variable Depth box contains the numeric value of the length of the extrusion. If the depth specification on the button to the left is not Variable, this text input area is grayed out. Just to the right of the depth value is the Flip button for reversing the direction of the protrusion (the magenta arrow).

Remove Material - this allows you to change the meaning of the solid feature from a protrusion (which adds solid material) to a cut (which removes solid material). Since there is nothing to remove at this time, this command is grayed out - all we can do is add.

Thicken Sketch - press this to see the solid block replaced by a thin-walled extrusion (formerly called a Thin Solid). A new dimension appears in the graphics window and on the dashboard. This is the thickness of the solid wall. Try changing this thickness to something like 2.0. On which side of the sketched curve has this been added? Another Flip button has also appeared. Press this a couple of times - it controls which side of the sketch the material is added to. Actually, it is a three way switch since you can also add material equally on both sides of the sketch. Press the Thicken button again to return to a full solid protrusion.
Just below this area of the dashboard are several drop-down panels which can be opened or closed by clicking on its label. The **Placement** panel is opened by default.

**Placement** - allows you to select, create, or modify the 2D section to be used for the feature. Since we preselected the sketched curve, it is now listed on this panel. If we had not preselected the curve, we could have chosen it now, or launched Sketcher from this panel to create a new sketch. This would involve selecting the sketching plane, sketcher reference, and so on. We will go this route in the next feature. If you wanted to change the sketch for the extrude, this is how you access it. The **Unlink** button is currently displayed on the **Placement** panel. This button appears if, like now, you have preselected a curve to serve as the sketch for the extrude. Thus, the extrude is linked to the previous curve feature; changes to the geometry or dimensions of the curve would drive changes in the shape of the extrude. The curve itself is a separate entry on the model tree. The purpose of unlinking is to break this (parent/child) connection to the original curve. If you were to select this command (**don’t do this now**), the copy of the original curve stored in the extrude feature would become independent. In that case, a change to the original curve would not affect the extrude. The original curve could be modified, moved, or even deleted, and the extrude would still be able to regenerate. The use of external curves to drive feature geometry is an important aspect of an advanced modeling technique that makes use of *skeleton models*, especially for mechanism design.

**Options** - (click the box to open this panel now. The **Placement** panel will close.) contains more information about the depth specification for the feature. We will find out what is meant by “Side 2” a bit later. Check out the **Add Taper** option (drag on the yellow drag handle, return to 0 when done).

**Body Options** - this is where you can specify which body the feature should belong to (the default is the currently active body), or create a new body. Leave this set to Body 1. Almost all the parts in this Tutorial will only use a single body.

**Properties** - specify the name of the feature, currently **EXTRUDE_1**.

As mentioned, to close a drop-down panel, just click on its tab in the dashboard. The drop-down panels can be detached from the dashboard and placed as separate windows anywhere in the graphics area. See Figure 28. They will stay there (and open), including for extrudes you create later, until you attach them back to the dashboard. Do that by either dragging the panel back up or clicking the **Attach** button.

**Figure 28** Detachable panels
at the top right of the panel windows.

As you explore the creation of new features in Creo Parametric you should investigate what is in each of these menus. They are context sensitive, so there is a lot of variety in what you will find, but all the dashboards basically operate the same way.

To the right on the dashboard are several common tools that appear for all features. See Figure 29. These function as follows:

**Pause** - allows you to temporarily suspend work on this feature so that you can, for example, create a missing reference like a datum plane, measure something in the model, etc. When you are finished with the side trip, press the symbol that appears here to continue where you left off.

**Preview Options** - (default = Attached) this is responsible for the shaded orange display of the feature under construction. Select the *No Preview* button - all you will see is the feature creation direction, drag handle, and depth dimension. Turn this back on.

**View Geometry** - this shows what the geometry will look like when the feature is fully integrated into the part. Not much happens with this first protrusion. Press again to return to preview.

**OK** and **Cancel** - do just what you expect!

Select **OK** (or middle click). The block now appears in the default neutral gray color, Figure 30, with its edges highlighted in green (last feature created).

We spent a lot of time discussing the creation of this feature so it maybe seemed like a lot of work. Let’s create it again without all the discussion. Select the **Undo** button at the top - this will delete the protrusion. Now create it again:

- highlight the sketched curve
- select the **Extrude** tool
- change the depth to **30**
- middle click.

Because of all the defaults, this only takes four clicks!

Open the Navigator pane to see the model tree, Figure 31. The default datum planes are listed. Then comes the sketched curve **Sketch 1** (hidden) and the extrude **Extrude 1**. Open the listing for the extrude and you will see the internal sketch (also **Sketch 1**) that uses the hidden curve and is currently linked to it. If you have used the **Unlink** button in
the Placement panel, the model tree will appear somewhat differently - the sketch stored inside the extrude is called S2D0001 and is independent of Sketch 1. The Bodies list under Design Items now indicates that it contains geometry (if you have the additional model tree columns as in Lesson 1). The extrude feature also indicates that it contributes to Body 1. Notice that datum features and sketches do not directly contribute to body definitions since they are not solid geometry. Close the Navigator.

<table>
<thead>
<tr>
<th>Feat #</th>
<th>Feat Type</th>
<th>Feature Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Contains Geometry</td>
</tr>
</tbody>
</table>

![Figure 31 Model tree of block.prt with first protrusion created](Figure31.jpg)

We will now add another extruded feature - this time we will create a cut that removes material. Furthermore, instead of creating the sketch first, as we did for the solid protrusion, we will create the sketch within the feature itself. This will follow Method #2 of Table 2-2 back on page 9 of this lesson. This is actually the more common way to use Sketcher, especially if the sketch will be used just once. Before we do that, now is a good time to save the part.

**Saving the Part**

It is a good idea when you are just getting started to save your model quite frequently, just in case something serious goes wrong. If you have to bail out of the program, you can always reload the most recently saved copy of the part and continue from there.

There are (as usual!) several ways to save the part:

- in the Quick Access toolbar, select the Save button, or
- in the pull-down menus select File > Save, or
- use the keyboard shortcut CTRL-S.

Make sure that the Save Object dialog is showing the desired working directory at the top. If not, select it in the Common Folders area in the Navigator. At the bottom of the dialog window, the name of the current active object (remember that you can have more than one object loaded into memory at a time) should already be in view. Accept the default model name [block] (this is the active part) by pressing the enter key or the middle mouse button. Creo will automatically put the part extension (.prt) on the file. If you save the part a number of times, Creo will automatically number each new saved
version (like block.prt.1, block.prt.2, block.prt.3, and so on). Be aware of how much space you have available. It may be necessary to delete some of the previously saved versions; or you can copy them to an archive location. You can do both of these tasks from within Creo - we'll talk about that later.

**IMPORTANT NOTE:**
The *Save* command is also available when you are in Sketcher. Executing this command at that time will *not* save the part but will save the current sketched section with the file extension *sec*. This may be useful if the sketch is complicated and may be used again on a different part. Rather than recreate the sketch, it can be read in from the saved file (using *Import*). In these lessons, none of the sketches are complicated enough to warrant saving them to disk.

Now we will proceed on to the next feature - an extruded cut. Make sure nothing is currently selected (highlighted) on the model (by clicking anywhere else in the window).

---

**Creating an Extruded Cut**

Following Method #2 of Table 2-2, start by launching the *Extrude* command from the ribbon. The extrude dashboard at the top of the screen opens. The *Placement* pull-down panel tab is red to indicate missing information there. Select *Define* or in the pop-up menu select *Define Internal Sketch*. The *Sketch* dialog window appears. This time, however, nothing has been preselected for us; we’ll have to enter the data ourselves.

In the Sketch window, notice the light green data entry field, called a *collector*, beside *Sketch Plane*. Whenever one or more references can be specified for something, they are placed into a collector. When a collector is active (ready to accept data) it is light green; otherwise it will be white. If you want to make a collector active, just click it.

Since the Sketch Plane collector is highlighted, the dialog is waiting for you to select the sketching plane (see the message line at the bottom of the window). Pay attention to preselection here. You will not be able to pick an edge or a curved surface (both of these would be illegal). Pick on the right side surface of the block (see Figure 32). As soon as you pick the sketching plane (it highlights in cyan), a magenta arrow will appear showing the default direction of view relative to the surface. The *Flip* button can be used to reverse this direction, but leave it as it is. Creo

---

11 On computers running Windows you will need to turn off the option “Hide extensions for known file types” in the *Folder Options > View* settings in Windows Explorer to see the file revision numbers.
makes a guess at a potential reference plane for you to use. This may depend on the current orientation of your view, and might result in a strange view orientation in sketcher (like sideways or even upside down). The sketch orientation reference serves another purpose that we will see in a minute, so we want to be a bit more careful and specific here. The collector for the sketch orientation reference surface is showing the default chosen. To override the default for the active collector, pick on the top planar surface (Figure 32) between the two tangent lines of the rounded corners; the surface will highlight in green. In the Orientation pull-down list, select Top so that the reference will face the top of the screen. We now have our sketch plane and reference set up, so select Sketch at the bottom of the dialog window. So that we are looking straight on to the sketching plane, select the Sketch View button in the Graphics toolbar. 

We are now in Sketcher (Figure 33). Two references (dotted lines) have been chosen for us (the back and top surfaces of the object). We are going to create the U-shaped figure shown in Figure 34. Note that there is no sketched line across the top of the U - there is no inside or outside. Thus, it is technically called an open sketch (as opposed to a closed sketch for our previous feature). There are some restrictions on the use of open sketches which we will run across in a minute or two.

Use the RMB pop-up menu to select the Line Chain command. Start your sketch at vertex 1 in Figure 34 - the cursor will snap to the reference. Then drag the mouse down and pick vertex 2 (note the Vertical constraint), and middle click twice to end the Line command. Some weak dimensions will appear. Do nothing about them yet because, since they are weak, they are liable to disappear anyway. If we make them strong, this will cause us extra work dealing with Intent Manager. The line is highlighted in green. Left click somewhere else to deselect the line.

Helpful Hint
Wait until the shape of the sketch is finished before you start worrying about the dimensioning scheme or dimension values.

---

12 A configuration option (sketcher_starts_in_2D) can make this automatic. This is also a handy command to add to the RMB pop-up menu using Customize.
Use the pop-up menu again and select the 3-Point Arc command. Pick on the end of the sketched line (vertex 2) and drag the mouse downwards in the direction of tangency. Once the arc has been established, drag the cursor over to the right (the arc will rubberband while maintaining the tangency constraint) and click at vertex 3. (If you drag straight across to vertex 3 you will get a 3-point arc which is not automatically tangent at vertex 2.) You should see horizontal constraint symbols that indicate when vertex 3 is at the same height as the center of the arc. Left click to create the vertex 3. Use the RMB menu to pick Line Chain again.

Now left click at vertex 3 and draw a vertical line up to snap to the reference at vertex 4, making sure that you have a tangent constraint at vertex 3. Our sketch is complete. Use the middle mouse button to return to Select mode. Your dimension values may be different from those shown in Figure 35. Your dimensioning scheme may even be slightly different. It will be easier to see this if you go to hidden line display instead of shading.

All the dimensions should be weak. Drag them to a better location if necessary (off the part). Don’t be afraid to resize your display so that you can see everything clearly. Compare the dimensioning scheme with the one in Figure 35. We want to have a horizontal dimension of 15 from the reference at the back of the part to the center of the arc of the U. If you do not have that dimension, we’ll have to add one manually. This will illustrate a case where we will override the Intent Manager.

To create your own dimension, select the Dimension command from the ribbon (or Dimension in the pop-up). Click on the vertex at the center of the arc (it will highlight) then click again on the dashed reference line at the right. Now middle click in the space above the part where you want the dimension text to appear. Set the value as shown in the figure. It’s that easy! Note that this dimension shows immediately in dark blue since it is strong. One of the weak linear dimensions should be gone. Middle click to get back to Select.

We now have the references, shape, implicit constraints and dimensioning scheme we want. So now we can worry about the dimension values. Get in the habit of dealing with your sketches in the following order (see the Helpful Hint on page 2-19):

Select References ➔
   Draw Shape ➔
   Assign Constraints ➔
   Setup Dimension scheme ➔
   Set Dimension values
Modify the values of the dimensions to match those in Figure 35.

Recall the hint above about open vs closed sketches. The sketch we have just produced will be able to produce the desired cut, but it is not the best we can do. The behavior of features constructed using open sketches is unpredictable. The danger lies in the possibility that something or someone may come along later to modify this part and add something to the top of the block earlier in the model tree. In that case, the cut feature would likely fail due to the uncertainty in what to do across the open ends of the sketch. So before we accept this sketch, let’s explore the diagnostics a bit.

### Helpful Hint
In general, try to keep your sketches closed - you will have fewer problems that way. Open sketches will be necessary only for special features or modeling requirements.

First, turn on the **Shade Closed Loops** and **Highlight Open Ends** buttons. Since the sketch is currently open it will not shade; the two ends will show the red squares. Select the **Feature Requirements** button in the ribbon. Notice the warning - the system is telling us that although this is not a fatal error, it is not a good idea. Close this window and create a line across the top of the sketch to close it (use **Line Chain** in the RMB pop-up). Now the sketch will shade, the red squares disappear. The sketch is now complete, so click on the **OK** button in the toolbar. If you are in hidden line display, return to shading display.

The feature will now be previewed. A couple of new buttons have appeared on the dashboard. First, in the **Depth Spec** pull-down list, there are a few more options available (Figure 36). For this cut, we would like the sketch to be extruded through the entire part, so pick the **Through All** option. Note that the dimension for a blind extrusion disappears from the screen. To the right of this area, click the **Flip** button (or the magenta arrow) to make the extrusion go through the part. The **Remove Material** button needs to be selected - finally we indicate that we are making a cut. Now, there are two magenta arrows attached to the sketch. The one perpendicular to the plane of the sketch shows the direction of the extrusion. The other shows which side of the sketched line we want to remove material from. These should be set as shown in Figure 37.

Now select the **Verify** button in the right area of the dashboard. If you have the **Remove Material** button set wrong, Creo Parametric will create a protrusion instead of a

---

13 This is one of the few times when a middle click does not mean **Accept**, which is a good thing since inadvertent middle clicks happen often when you are in Sketcher.
Even worse, if we had left the sketch open, the protrusion would fail. This sketch is ambiguous since when the sketch starts out from the sketch plane, the vertices at the ends are out in the open air; Creo Parametric would not know how to create the solid to attach it to the existing part. This problem does not occur with a cut as long as the open ends of the sketch stay outside or on the surface of the part. You might come back and explore this later.

Another common error with cuts is having the material removal side set wrong (the second magenta arrow in Figure 37). If you do that for this part, you will end up with Figure 38. Make sure the material removal arrow points to the inside of the U. Plus, you should explore the Placement, Options, Body Options, and Properties menus on the dashboard before you leave.

We are finished creating this feature, so select the OK button at the right end of the dashboard. Open the Bodies list under Design Items. Set the Selection Filter to Body, pick on one of the surfaces, then in the RMB pop-up menu, select the Make Transparent command. As long as model colors are turned on, even the default neutral gray body will become partially transparent. You can set the transparency using the control in the graphics toolbar. The part should now look like Figure 39. The cut will be highlighted in green as usual, as the last feature created.

Save the part (Ctrl-S). We will need it in this condition for the next chapter. Notice that there are no defined view orientations for the part, like FRONT, RIGHT, and so on. Since those are so commonly used, it will be handy if they could be created.

Even worse, if we had left the sketch open, the protrusion would fail. This sketch is ambiguous since when the sketch starts out from the sketch plane, the vertices at the ends are out in the open air; Creo Parametric would not know how to create the solid to attach it to the existing part. This problem does not occur with a cut as long as the open ends of the sketch stay outside or on the surface of the part. You might come back and explore this later.
Creating a Simple Object (Part I) 2 - 31

automatically. That is one of the reasons to use a part template. Read on!

---

**Using Part Templates**

You will recall that, in creating the block part, the first thing we did was to create default datum planes. These are very standard features and aspects of part files, and it would be handy if this was done automatically. This is exactly the purpose of part templates.

A template is a previously created part file that contains the common features and aspects of almost all part files you will ever make. These include, among other things, default datum planes and named views. Creo has several templates available for parts, drawings, and assemblies. Your local installation may have more, and you can create your own templates as well. There are variations of the templates for each type of object. One important variation consists of the unit system used for the part (inches or millimeters). Templates also contain some common model parameters and layer definitions.15

A template can be selected only when a new model is first created. Let’s see how that works. Create a new part (note that you don’t have to remove the block - Creo can have several parts “in session” at the same time) by selecting

`File ➤ New`

or using the “Create New Object” button in the Quick Access toolbar. The `New` dialog window opens. The `Part | Solid` options are selected by default. Enter a new name, like `exercise_1`. Remove the check mark beside `Use default template` (we normally don’t do this, but we should have a look at what is available) and then select `OK`.

In the `New File Options` dialog window, the default template is shown at the top. It is likely “inlbs_part_solid_abs” (unless your system has been set up differently). This template is for solid parts with the units set to inch-pound-second. The “_abs” refers to a setting (absolute vs relative) for the internal accuracy of the computations in Creo. Absolute accuracy is recommended. It seems strange to have force and time units in a CAD geometry program. Actually, this is included so that the part units are known by downstream applications like Creo Simulate which perform finite element analysis (FEA) or mechanism dynamics calculations. These programs both require force, mass, and/or time in their operation and are very picky about units!

Note that there are templates available for metric units (millimeter-Newton-second) in both absolute and relative accuracy versions. While we are mentioning units, be aware that if you make a wrong choice of units here, changing units or accuracy setting of a part is possible after it has been created (see `File ➤ Prepare ➤ Model Properties`).

There are only two model parameters in the default template. `DESCRIPTION` is for an

---

15 Model parameters and layers are discussed in the *Advanced Tutorial.*
extended title for the part, like “UPPER PUMP HOUSING”. This title can (eventually) be called up and placed automatically on a drawing of the part using, you guessed it, a drawing template. Similarly, the MODELED_BY parameter is available for you to record your name or initials as the originator of the part. Fill in these parameter fields (“Creo Exercise #1” and your initials) and select OK.

The new part is created which automatically displays the default datums. They are even named for you (we will see how to name features in lesson 3): instead of DTM1, we have RIGHT. TOP replaces DTM2, and FRONT replaces DTM3. The part also contains a coordinate system, named views (look in the Saved Orientations List), and other data that we’ll discover as we go through the lessons. The named views correspond to the standard engineering views. Thus, it is important to note that if you are planning on using a drawing template that uses these named views, your model orientation relative to the default datums is critical. The top-front-right views of the part are the ones that will be automatically placed on the drawing later. If your model is upside down or backwards in these named views, then your drawing will be too. This is embarrassing and not likely to win favor with your boss or instructor!

Now, having created this new part, you are all set up to do some of the exercises at the end of the lesson. Do as many of these as you can. Perhaps do some of them in different ways by experimenting with your sketch orientation, Sketcher commands, and so on.

This completes Lesson #2. You are strongly encouraged to experiment with any of the commands that have been presented in this lesson. Create new parts for your experiments since we will need the block part in its present form for the next lesson. In the next lesson we will add some more features to the block, discover the magic of relations, and spend some time learning about the utility functions available to give you information about the model.

Questions for Review

Here are some questions you should be able to answer at this time or that might require you to do some digging around the on-line Help area or just play with the software.

1. What is meant by a blind protrusion?
2. What is the purpose of the sketching reference?
3. How do you specify the name of a part?
4. Give as many of the Sketcher implicit rules as you can.
5. How do you save a part?
6. What is a template?
7. What is your system’s default template? What units does it use?
8. Where does your system store your part files when they are saved?
9. What is meant by the active part?
10. How does Sketcher determine the radius of a fillet created on two lines?
11. What happens if you delete any of the constraints on a sketch?
12. In an extrude, what happens if you set the thickness of a thickened sketch greater than the radius of a filleted corner of the sketch?
13. What is meant by Linking to a sketch?
14. In Sketcher, what is the difference between light blue, dark blue, green, and red dimensions?
15. In Sketcher, how do you create an explicit dimension? Is this weak or strong?
16. In Sketcher, how do you indicate where you want the dimension text placed?
17. What are the commands available for diagnosing errors in sketches?
18. How do you turn on the Sketch grid?
19. What are three ways to create a strong dimension?
20. How do you create a weak dimension (trick question!)?
21. In Sketcher, how do you create a radius dimension? A diameter dimension?
22. In Sketcher, what dimension is created if you left click on an arc or circle, then on a planar reference, then middle click to place the dimension?
23. What kind of dimensions are created in Sketcher for the sloping line in the figure at the right if you pick the end vertices then you middle click in regions A, B, or C?
24. When would you normally create a sketch embedded within a feature, as opposed to a separately created curve?
25. What is the sketching reference plane used for?
26. What is the default direction for the normal to a datum plane? A solid surface?
27. What is the purpose of the Pause button on the feature creation dashboard? What about the Preview check box? How is Preview different from Verify?
28. In Sketcher, what is the difference between a geometry element and a construction element? What types of elements does this refer to?
29. What are the nine explicit constraints in Sketcher?
30. What are two ways of finding out if a sketch is open or closed?
31. How can you find overlapping entities in a sketch?
32. How do you specify whether you want to create an extruded solid or an extruded surface? What about an extruded cut?
33. In the extrude preview, what is on the RMB menu associated with the depth drag handle?
34. When/how do you attach a feature to a body?
35. What features will NOT contribute to a body?
36. What are the drop-down panels in the Extrude dashboard? What information do they contain? How do you attach/detach them?
37. What is a “collector”? What indicates that it is expecting input?
38. How can you customize the pop-up menus?
Exercises

Here are some simple shapes that you can make with simple extrusions. They should give you some practice using the Sketcher drawing tools and internal rules. Choose your own dimensions and pay attention to alignments and internal constraints. The objects should appear in roughly the same orientation in default view. Have a contest with a buddy to see who can create each object with the fewest number of dimensions. This is not necessarily a goal of good modeling but is a good exercise! Feel free to add additional features to these objects.
The following two parts “bushing” and “washer” will be needed later (Lesson #9 Assembly Fundamentals). Save them in a safe place.

7. Bushing

![Bushing dimensions](image)

8. Washer

The easiest way to make this is to do a Save A Copy of the bushing part (giving a new name washer), File > Open the new part, then double-click on the protrusion and edit the dimensions.

The next parts are a bit more complicated, requiring two or more simple extruded features (protrusions or cuts). Think about these carefully before you try to make them.

9. 

10. 

11.
This page left blank.